Operation

TEAM 5001

for NetView/AIX
Version 2.0.0

General DataComm
Warranty

General DataComm warrants that its equipment is free from defects in materials and workmanship. The warranty period is one year from the date of shipment. GDC's sole obligation under its warranty is limited to the repair or replacement of the defective equipment provided it is returned to GDC, transportation prepaid, within a reasonable period. This warranty will not extend to equipment subjected to accident, misuse, or alterations or repair not made by GDC or authorized by GDC in writing. *The foregoing warranty is exclusive and in lieu of all other warranties, express or implied, including but not limited to, warranties of merchantability and fitness for purpose.*

Trademarks and Patents

General DataComm, the General DataComm logo and the following are trademarks of General DataComm, Inc in the United States and other countries: ACCULINE, ANALOOP, AUTOFRAME, BERT 901, DATACOMM SECURE-PAK, DATALOOP, DIGIDIAL, ENmacs, FASTPRO, FIRST RESPONSE, GDC, GDC APEX, GENERAL DATACOMM X-PRESS, GEN*NET, GEN*PAC, IMAGE*TMS, KILOMUX, LAN*TMS, MEGA*BRIDGE, MEGAMUX, MEGAMUX TMS, MEGANET, MEGASPLIT, MEGASWITCH, MEGAVIEW, NETCON, NETSWITCH, NMC, QUIKSHIPPERS, SERVI-CHECK, SERVI-SNAP, WINmacs.

ANALOOP and DATALOOP respectively are protected by U.S. patents 3,655,915 and 3,769,454. All other products or services mentioned in this document are identified by the trademarks, service marks, or product names as designated by the companies who market those products. Inquiries concerning such trademarks should be made directly to those companies.

Copyright

© 1997 General DataComm, Inc. All rights reserved.
P.O. Box 1299, Middlebury, Connecticut 06762-1299 U.S.A.

This publication and the software it describes contain proprietary and confidential information. No part of this document may be copied, photocopied, reproduced, translated or reduced to any electronic or machine-readable format without prior written permission of General DataComm, Inc.

The information in this document is subject to change without notice. General DataComm assumes no responsibility for any damages arising from the use of this document, including but not limited to, lost revenue, lost data, claims by third parties, or other damages. If you have comments or suggestions concerning this manual, please write to Technical Publication Services or call 1-203-758-1811.
# Table of Contents

## Preface

### Introduction

- Overview ................................................................................................................................1-1
- SC 5000 System Components .................................................................................................1-1
- SC 5001 LTU ..........................................................................................................................1-2
- TEAM 5001 Applications ......................................................................................................1-2

## Operations

### Introduction

- Map Window Menu Bar Access ............................................................................................2-1
- SC 5001 LTU Front Panel ......................................................................................................2-2
- Common Window Features .....................................................................................................2-6
- Monitor Functions ..................................................................................................................2-6
  - Alarms ................................................................................................................................2-6
  - Local Reports ......................................................................................................................2-9
  - ANSI Reports ......................................................................................................................2-10
  - Alarm Counts ......................................................................................................................2-10
  - Statistics Polling ................................................................................................................2-11
- Administer Functions ...........................................................................................................2-12
  - Configuration ......................................................................................................................2-12
  - SC 5001 Maintenance ..........................................................................................................2-13
- Diagnostics ...........................................................................................................................2-13
- Miscellaneous Functions .......................................................................................................2-13
  - Information .........................................................................................................................2-13
  - Front Panel Poll Rate .........................................................................................................2-14
  - Note Pad ..............................................................................................................................2-14

## Configuration

### Introduction

- To Start TEAM 5001 Configuration ......................................................................................3-1
- Templates ...............................................................................................................................3-1
- Configuration Procedure ........................................................................................................3-1
  - Configuration Option Values ............................................................................................3-2
  - Main Configuration Window ..............................................................................................3-2
### Table of Contents

- **Main Configuration Window Read-Only Display** ........................................................... 3-3
- **Shelf Options** .................................................................................................................. 3-4
- **TEAM 5001 Options** ....................................................................................................... 3-5
- **Alarms** ............................................................................................................................ 3-9
  - Buttons and Option Selection ...................................................................................... 3-9
  - Alarms Reported Buttons ......................................................................................... 3-10
  - Alarms Reported Fields ............................................................................................. 3-10

### Maintenance

- **Introduction** .................................................................................................................... 4-1
- **To Start TEAM 5001 Maintenance** ............................................................................... 4-1
- **Maintenance Procedure** .............................................................................................. 4-2
  - Maintenance Window Buttons ................................................................................... 4-2

### Diagnostics

- **Introduction** .................................................................................................................... 5-1
- **Diagnostics Window** ..................................................................................................... 5-1
- **DS0 Tests** ....................................................................................................................... 5-2
  - DS0 End-to-End Test Procedure ................................................................................ 5-2
  - DS0 Loop Test Procedure ......................................................................................... 5-3
- **DS1 Tests** ....................................................................................................................... 5-4
  - DS1 Line, Payload, and Cascade Loopback Procedure ............................................. 5-4
  - DS1 Local Test Procedure ......................................................................................... 5-5
  - DS1 Remote Loop Procedure .................................................................................... 5-6
  - DS1 Network Interface Loopback Procedure ........................................................ 5-7
- **DS0 Delay Test** ............................................................................................................... 5-7
- **DS1 Receive Level** ......................................................................................................... 5-8
- **Diagnostics History** ...................................................................................................... 5-8
Scope

This manual describes how to operate Version 2.0.0 of the GDC TEAM 5001 software application. The TEAM 5001 software employs the Simple Network Management Protocol (SNMP) to configure and control the operation of GDC SpectraComm 5001 Line Terminating Units (LTUs). It can be launched under IBM NetView to run on the AIX operating system.

The SC 5001 LTU performs T1 network interface functions for a group of data set emulators (DSEs) installed with it in a SpectraComm shelf. The DSEs perform DTE interface functions.

The TEAM 5001 application communicates with the LTU through a SpectraComm Manager (SCM) card that also occupies the SpectraComm shelf.

This manual assumes you are familiar with NetView and with T1 digital transmission products.

Revision History

This is the initial issue of the manual for Version 2.0.0 of the TEAM 5001 software for NetView. Version 2.0.0 is the first TEAM 5001 software to operate in the NetView environment. Earlier versions operated exclusively in an HP OpenView environment. NetView and OpenView are functionally identical, though they differ in some menu terminology.

Organization

This manual has five chapters:

Chapter 1, Introduction, provides a high-level overview of the TEAM 5001 system components.

Chapter 2, Operation, covers the two means of access to the TEAM 5001 applications: the shelf map menu bar, and the Front Panel window Select button menus. The chapter fully describes the functions that can be selected from the Monitor and Misc menus. This chapter also describes how to access the Configuration, Maintenance, and Diagnostics applications.

Chapters 3, Configuration, provides detailed instructions for using the TEAM software to configure your Line Terminating Unit (LTU).

Chapter 4, Maintenance, documents three maintenance functions that you can use to set maintenance options for the LTU.

Chapter 5, Diagnostics, details the diagnostic tests that you may run on the LTU.
Document Conventions

This manual uses three levels of headings to visually and logically organize information.

Level 1 Headings

Level 1 paragraph headers introduce major topics.

Level 2 Headings

Level 2 paragraph headers introduce subsections of major topics.

Level 3 Headings

Level 3 paragraph headers introduce subsections of secondary topics.

Typefaces and Fonts

This typewriter font shows output that is displayed on the screen.

This bold font shows specific input that you type at the keyboard.

This bold italicized font shows variable input that you type at the keyboard

Notes present special instructions, helpful hints or general rules.

Related Publications

The following documents have information that may be helpful when using this product:

<table>
<thead>
<tr>
<th>GDC Number</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>058R720-1160</td>
<td>TEAM Core Operation - NetView/AIX</td>
</tr>
<tr>
<td>076R100-000</td>
<td>SpectraComm 5001 LTU Installation &amp; Operation</td>
</tr>
</tbody>
</table>

GDC publication numbers (e.g., GDC 032R163-000) are used to track and order technical manuals. Publication numbers use the following format:

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn

- NNN identifies the product family (e.g., TEAM)
- R denotes a technical publication
- nnn a number assigned by Technical Publications
- 000 identifies a hardware product and does not change
- Vnnn the software version associated with a product may be updated periodically

The issue number on the cover only changes when a hardware manual is revised or when a manual is reprinted for some other reason; it does not automatically change when the software is updated. A new Software Version is always Issue 1. Other specialized publications such as Release Notes or Addenda may be available depending on the product.
1 Introduction

Overview

This manual covers the General DataComm TEAM 5001 application. The application can be launched under IBM NetView to run on an AIX platform. You should be familiar with NetView and with T1 digital transmission products in order to use this manual effectively.

The TEAM 5001 application is composed of integrated smaller applications that manage various aspects of GDC SC 5001 Line Terminating Unit (LTU) cards. The applications use the Simple Network Management Protocol (SNMP). The SC 5001 LTU is part of the SpectraComm 5000 (SC 5000) system.

TEAM 5001 applications enable you to

• **Configure** SC 5001 LTUs.
• **Monitor** the operation of LTUs through displays of alarms and other operating status information, and through a Front Panel display that shows LED indicators as they appear on the front panel of the physical unit.
• **Diagnose** suspected problems using local and remote loops (with or without Self Test) and end-to-end Self Test.

SC 5000 System Components

SC 5000 hardware consists of three types of components:

• **Line Terminating Unit (LTU)**
• **Data Set Emulator (DSE)**
• **SpectraComm Manager (SCM)**

Line Terminating Unit (LTU)

The Line Terminating Unit (LTU) performs network interface and channel grooming functions for a group of DSEs. An SC 5001 LTU connects to a T1 line, over which it transmits the combined data traffic of up to 24 DSEs to a Telco switching site. On the T1 line, the data for each DSE occupies one or more DS0s: an SC 5520 DSE employs a single DS0; an SC 5034 DSE employs two DS0s, one for each modem channel; an SC 5553 DSE can employ as many DS0s as its fractional T1 function requires, from 1 to 24. Telco switching equipment routes the DS0s of the T1 line from the SC 5000 site to their individual remote destinations. In this way a single T1 connection between an SC 5000 site and a Telco switching site can support voice grade or DDS connections (each occupying one DS0) with up to 24 remote sites. Fractional T1 DSEs reduce the number of remote sites to which one LTU can support links.
**Data Set Emulator (DSE)**

The Data Set Emulator (DSE) performs DTE interface functions in a manner that emulates the operation of a traditional data set directly connected to a telephone line. For example, an SC 5034 DSE supports two modem channels each of which appears to its DTE and to its remote modem to be a V.34 modem; an SC 5520 DSE emulates the functions of a GDC NMS 520 Data Service Unit. Rather than being directly connected to a Telco network, however, each DSE transmits and receives data through a data highway incorporated in the backplane of the SpectraComm shelf. The data highway links the DSE to an LTU. Each DSE is managed by its own TEAM application.

**SpectraComm Manager (SCM)**

A SpectraComm Manager (SCM) card acts as the SNMP agent through which TEAM management applications communicate with SC 5000 components. All management communications are directed to the SCM card Internet Protocol (IP) address. The SCM card relays commands and responses between management applications and hardware components, using a slot addressing scheme to communicate over the SpectraComm shelf backplane with the other SC 5000 components. The SCM is transparent to the applications, which operate as though they were communicating directly with the hardware units. The SCM card is managed by the TEAM Core application, which is also responsible for the Discovery and Mapping functions that keep track of the devices being managed.

**SC 5001 LTU**

An SC 5001 LTU performs network interface functions for the SC 5000 system. On its network side, it connects to a T1 line, composed of 24 DS0s, over which it can transmit and receive data at up to 1.54 Mbps. The LTU can be configured to operate in either of two modes: Concentrator or CSU.

In Concentrator mode the LTU interfaces through the SpectraComm shelf backplane data highway bus with a group of DSEs, each of which supplies data for one or more DS0s. Any DS0s not employed for DSE data highway traffic can be employed to support traffic through the DSX-1 Cascade port of the LTU.

In CSU (channel service unit) mode the DSX-1 Cascade (or equipment) port is the only local interface for the LTU. The LTU does not support DSE data highway traffic while it is in CSU mode.

**TEAM 5001 Applications**

The applications that make up the TEAM 5001 manager are grouped on menus under the headings Monitor, Administer, Diagnose, and Misc (Miscellaneous). Menus for the applications are available in two ways:

- From the menu bar of the shelf map window when an SC 5001 LTU is selected in the window
- From the Select button on the SC 5001 Front Panel display.

SC 5001 Front Panel displays current status information on the SC 5001 LTU by displaying the states of the LED indicators on the front panel of the unit; and provides Select button menus by which you can invoke all other functions of the TEAM 5001 manager. You can launch the Front Panel display from the shelf map window by means of the Front Panel selection in the Monitor menu or by double clicking on the shelf icon of the LTU you need to work with.
The following TEAM 5001 applications appear on the map window and Select button menus:

- **Monitor:**
  - Alarm Detail – furnishes information about alarm state changes.
  - Front Panel – launches the Front Panel display (selection appears only on Map window menu).
  - Local Reports – displays accumulated statistics on LTU operation when it is configured to operate in an ESF Mode TR 54016 network environment.
  - ANSI Reports – displays accumulated statistics on LTU operation when it is configured to operate in an ANSI mode network environment.
  - Alarm Counts – displays current statistics on alarm conditions experienced or detected by the LTU.
  - Statistics Polling – displays a Real Time Statistics window that contains running counts of six types of error conditions and percentage of error free seconds.

- **Administer:**
  - Configuration – enables you to configure SC 5001 LTUs.
  - Maintenance – enables you to set device specific attributes that are not set as configuration options.

- **Diagnose** – enables you to run diagnostic tests on SC 5001 LTUs.

- **Misc:**
  - Information – displays revision and copyright information for the application.
  - Front Panel Poll Rate – enables you to adjust the rate at which the application polls the LTU while the Front Panel display is on-screen.
  - Note Pad – provides access to a text editor.
2 Operations

Introduction

The TEAM 5001 controller application consists of a group of smaller applications, each devoted to a specific aspect of controlling or monitoring the SC 5001 Line Terminating Unit. There are two means of access to the TEAM 5001 applications: the shelf map menu bar, and the Front Panel window Select button menus. This chapter describes both.

On the shelf map menu bar there are six selections in the Monitor category: Front Panel, Alarm Detail, Local Reports, ANSI Reports, Alarm Counts, and Statistics Polling. The Front Panel selection launches the Front Panel display window that shows the state of indicators at the LTU. The Select button menu incorporated in the Front Panel display provides access to most other TEAM 5001 functions (the Front Panel function itself isn’t included in the Select button menu). The other selections in the Monitor menu display read-only windows that pertain to various aspects of LTU operation. This chapter fully describes the Monitor menu applications.

There are two applications in the Administer category: Configuration and Maintenance each support read/write windows by which you can review and alter LTU operating parameters. This chapter describes how to access the Configuration and Maintenance applications. Instructions for using the two applications appear in subsequent, individual chapters.

The Diagnostic application supports a read/write window by which you can command the test functions of the LTU and view test results. This chapter describes how to access the Diagnostic application. Instructions for using the application appear in a subsequent chapter.

Three items appear on menus as Misc (miscellaneous): Information, Front Panel Poll Rate, and Note Pad.

Map Window Menu Bar Access

The table on the following page illustrates how the TEAM 5001 application functions are arranged on the menu bar at the top of the Map window. The table shows only the menu selections for the TEAM 5001 applications. The map window menus include selections in addition to those that apply to TEAM 5001 because the window also provides access to other applications.

You must select the LTU you intend to work with before you open the menu you intend to use. Select the LTU by clicking the mouse on its icon in the shelf map.
The Monitor menu Front Panel selection opens the Front Panel display window. The other selections in these menus correspond to selections in the Front Panel window Select button menus.

**SC 5001 LTU Front Panel**

The SC 5001 Front Panel display window (*See Figure 2-1*) provides a graphical interface to a selected SC 5001 LTU. You can launch a Front Panel in either of two ways:

- select the unit you intend to work with in the Map window, then select Front Panel from the Monitor menu for that window

- display the shelf sub-map that includes the unit you intend to work with, then double click the mouse on the slot icon for the unit.

The application responds by displaying a window that depicts the front panel of the SC 5001 LTU unit.
**Figure 2-1**  SC 5001 LTU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical unit:

<table>
<thead>
<tr>
<th>LED</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>INS</td>
<td>In Service, indicates when lit that the unit is configured and operating</td>
</tr>
<tr>
<td>ON</td>
<td>Power On</td>
</tr>
<tr>
<td>TMG</td>
<td>Timing, indicates when lit that the LTU is the source of 4 MHz timing for its shelf</td>
</tr>
<tr>
<td>RSP</td>
<td>Response, indicates when lit that the LTU is transmitting a response to a network controller command</td>
</tr>
<tr>
<td>EQ O’S</td>
<td>Cascade Zeros, indicates when lit that the LTU is transmitting excessive zeros, received through its cascade port, onto the T1 line</td>
</tr>
<tr>
<td>EQ LAD</td>
<td>Cascade Low Average Density, indicates when lit that the LTU detects a low average density of ones in incoming data at its cascade port</td>
</tr>
</tbody>
</table>
### LED Meaning

<table>
<thead>
<tr>
<th>LED</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ OOF</td>
<td>Cascade Out of Frame, indicates when lit that the LTU cannot synchronize to the DSX-1 signal at its cascade port</td>
</tr>
<tr>
<td>EQ NS</td>
<td>Cascade No Signal, indicates when lit that the LTU is not receiving a DSX-1 signal at its cascade port</td>
</tr>
<tr>
<td>NK BPV</td>
<td>Network Bipolar Violation, indicates when lit that the LTU has detected a bipolar violation in the incoming T1 signal</td>
</tr>
<tr>
<td>NK AIS</td>
<td>Network Alarm Indication Signal, indicates when lit that the LTU has detected a network AIS (all ones) in the incoming T1 signal</td>
</tr>
<tr>
<td>NK OOF</td>
<td>Network Out of Frame, indicates when lit that the LTU cannot synchronize to the T1 signal</td>
</tr>
<tr>
<td>NK NS</td>
<td>Network No Signal, indicates when lit that the LTU is not receiving a signal on the T1 line</td>
</tr>
<tr>
<td>TM</td>
<td>Test Mode</td>
</tr>
<tr>
<td>ALM</td>
<td>Alarm, indicates by its color, which matches that of the SC 5001 Shelf submap icon for the unit, that the LTU has detected an alarm condition</td>
</tr>
<tr>
<td>ST</td>
<td>Self Test, indicates when lit that Self Test is active on the LTU</td>
</tr>
<tr>
<td>LT</td>
<td>Local Test, indicates when lit that the LTU is in a local loopback test mode</td>
</tr>
<tr>
<td>RL</td>
<td>Remote Loop, indicates when lit that the LTU is in a remote loopback test mode</td>
</tr>
</tbody>
</table>

The application polls the LTU to keep the states of the LEDs in the Front Panel display current. The time of the most recent poll appears at the bottom of the Front Panel display, to the left of the Help button. The time is displayed in white when Auto Poll is enabled, and in yellow when it is disabled.

The Select button at the bottom of the Front Panel display provides access to menus for the rest of the TEAM 5001 application functions.
The following table shows the arrangement of the Select button menus. It differs somewhat from the arrangement on the Map window menu bar.

<table>
<thead>
<tr>
<th>Select Button Menu</th>
<th>Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Alarms...</td>
</tr>
<tr>
<td></td>
<td>Alarm Counts...</td>
</tr>
<tr>
<td></td>
<td>Local Reports...</td>
</tr>
<tr>
<td></td>
<td>ANSI Reports...</td>
</tr>
<tr>
<td></td>
<td>Statistics Polling...</td>
</tr>
<tr>
<td>Administer</td>
<td>Configure...</td>
</tr>
<tr>
<td></td>
<td>Maintenance...</td>
</tr>
<tr>
<td>Diagnose</td>
<td>Diagnose...</td>
</tr>
<tr>
<td>Demand Poll</td>
<td>Auto Poll (*)</td>
</tr>
<tr>
<td></td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>30 seconds</td>
</tr>
<tr>
<td></td>
<td>60 seconds</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
</tr>
<tr>
<td>Exit</td>
<td>* Displays Off or poll interval</td>
</tr>
</tbody>
</table>

The two Poll selections in the Select button menu determine when the application collects new information from the LTU to update the Front Panel window:

- Selecting Demand Poll causes an immediate update of the display.
- Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable automatic polling. If you select Disable, the Front Panel window displays a static snapshot of the LED states as they were at the last poll, either when the window was launched or a subsequent Demand Poll.

Each time the Front Panel display is opened, its initial polling rate is determined by the Front Panel Poll Rate selection of the map window Misc menu.

The menu selection Exit dismisses the Front Panel window when you click on it.
Common Window Features

Each TEAM 5001 application you select opens an on-screen window in which to operate. A number of features are common to many of the windows:

Triangle button – in the title bar; reduces the window to an icon when you click on it. Double clicking on icon restores the window. This button appears on the top level window for each application.

Title bar – identifies the specific TEAM 5001 application running in the window; for example TEAM 5001 Main Configuration or TEAM 5001 Diagnostics.

Menu bar – always contains the selections File, on the far left, and Help, on the far right. File menu always contains the selection Exit, by which you can dismiss the window; some window File menus contain selections special to the window. Help menu provide access to information concerning the window. Some windows have additional Menu bar selections.

The Menu bar appears on the top level window for each application. A Menu bar appears in the Main Configuration window, for example, but not in the windows you access from Main Configuration.

Name field – identifies the SC 5001 the application is currently connected to by displaying the user-configured shelf name, followed by the LTU slot number, the selected modem channel (A or B), and the user-configured device name.

Descriptions in this manual of the individual TEAM 5001 applications identify window features that are specific to the applications, such as selections in the Menu bar and menus, and buttons.

Monitor Functions

Six functions appear on the Monitor menu when you access it from the map window menu bar, five when you access it from the Front Panel Select button menu. The Front Panel display itself is a selection in the menu bar version of the menu. The following pages describe the five functions common to both menus, all of which display information about the unit and its operation.

Alarms

You can launch the TEAM 5001 Alarm application from the Monitor Menu of the Map window or from the front panel menu. The application displays the read-only Alarms Detail window for the selected LTU (See Figure 2-2).

The TEAM 5001 application gets alarm indications from the LTU in two ways:

- By receiving traps that the SCM sends automatically in response to alarm conditions at the LTU
- By polling the SCM for changes in alarm conditions at the LTU.
The Alarm Detail window displays alarms grouped into three categories:

- **Major**
- **Minor**
- **Informational**

### Major Alarms

- NV RAM Corrupt – occurs when the LTU computes a checksum for its software configuration that does not match the one it stored at the time of configuration
- Unit Failure – occurs when the LTU fails its Power On Self Test
- Timing Loss – occurs when the LTU loses timing from its configured transmit clock source
- Network Loss of Signal – occurs when the LTU detects absence of signal on the T1 line
- Cascade Loss of Signal – occurs when the LTU detects absence of signal at its DSX-1 cascade port
- Network Out of Frame – occurs when the LTU cannot synchronize to the signal on the T1 line
- Cascade Out of Frame – occurs when the LTU cannot synchronize to the signal at its DSX-1 cascade port
- Network Alarm Indication Signal – occurs when the LTU receives an AIS (all ones) signal on the T1 line
- Cascade Alarm Indication Signal – occurs when the LTU receives an AIS (all ones) signal at its DSX-1 cascade port
- Network Unavailable Signal State – occurs when the LTU experiences ten consecutive severely errored seconds at its T1 interface
- Cascade Unavailable Signal State – occurs when the LTU experiences ten consecutive severely errored seconds at its DSX-1 cascade port
Minor Alarms

- Network Received Yellow – occurs when the LTU receives a Yellow alarm at its T1 interface
- Cascade Received Yellow – occurs when the LTU receives a Yellow alarm at its DSX-1 cascade port
- Network Bipolar Violations – occurs when the signal the LTU receives at its T1 interface does not alternate between signal levels as required by AMI or B8ZS coding
- Cascade Bipolar Violations – occurs when the signal the LTU receives at its DSX-1 cascade port does not alternate between signal levels as required by AMI or B8ZS coding
- Network CRC Errors – occurs when the cyclic redundancy checksum the LTU computes for an ESF frame received at its T1 interface does not match the checksum transmitted with the frame
- Cascade CRC Errors – occurs when the cyclic redundancy checksum the LTU computes for an ESF frame received at its DSX-1 cascade port does not match the checksum transmitted with the frame
- Network Excessive Zeros – occurs when the LTU has to insert ones in the data it is transmitting in order to satisfy its configured ones density requirements. Valid when LTU is configured for 8(N+1).
- Network Low Average Density – occurs when the LTU has to insert ones in the data it is transmitting in order to satisfy its configured ones density requirements. Valid when LTU is configured for Max 15 Zeros or Max 39 Zeros.
- Network Controlled Frame Slips – occurs when the LTU has to either replicate or delete a received frame in order to compensate for synchronous timing differences between itself and the received signal great enough to exhaust its buffer capacity

Informational Alarms

- Power Up – occurs each time the LTU is turned On or reset
- Unsolicited Test – occurs when the LTU enters a test mode that is commanded by its front panel or the network rather than by the TEAM 5001 application
- MBI Lock – occurs when the LTU loses its timing reference from the SpectraComm shelf backplane
- Local Power Fail – occurs when LTU operating voltage falls below its designated level
- Fallback Timing – occurs when LTU is operating with the fallback timing source configured for it in the Shelf Configuration application of the TEAM Core software

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar.

The File menu contains only the selection Exit, by which you can dismiss the window.

The View menu consists of three selections: Major, Minor, and Informational, each with a check box beside it. To remove an alarm category from the window display, click on its check box so that it is unchecked. Clicking a box so that it is checked restores the corresponding category to the display.
Local Reports

You can launch the TEAM 5001 Local Reports application from the Monitor Menu of the Map window or from the front panel menu. The application displays Maintenance Message statistics that the LTU accumulates when it is configured to operate in ESF Mode TR 54016.

The report data covers 24 hours of operation, broken into 15-minute intervals. For each interval the report displays the number of occurrences of specified error events.

*Figure 2-3* illustrates a Local Report window.

![Local Reports Window](image)

Maintenance Message statistics include the categories:

- **Errored Seconds** – in which the LTU detects a single LCV or CRC error event in the signal it is receiving
- **Unavailable Seconds** – which begin to be counted when a Severely Errored Second condition at the LTU persists for ten seconds or more
- **Bursty Errored Seconds** – in which the LTU detects more than 1 and fewer than 320 CRC error events in the signal it is receiving
- **Severely Errored Seconds** – in which the LTU receives 30% or more error-containing blocks, or suffers a LOF condition
- **Loss of Frame Counts** – count of instances in which the LTU cannot synchronize to the signal on the T1 line
- **Controlled Slip Seconds** – count of seconds in which the LTU has had to replicate or delete one or more frames of data to compensate for synchronization problems that exceeded buffer capacity
Local Report Window Menus

The Local Reports window has File and Edit menus in its menu bar.

The File menu consists of Refresh and Exit selections. The Refresh selection causes the application to acquire the most recent data for the display. The display does not update automatically, so you should use the Refresh occasionally when have the window open for an extended period. The Exit selection dismisses the Local Reports window.

The Edit menu consists of the selections Clear Results and Resync Timer. Clear Results deletes all entries currently stored for display in the window. Resync Timer enables you to select the time that elapses before the application refreshes the window following a Clear Results.

ANSI Reports

You can launch the TEAM 5001 ANSI Reports application from the Monitor Menu of the Map window or from the front panel menu. The application displays statistics that the LTU accumulates when it is configured to employ ANSI frame formatting.

Figure 2-5    ANSI Reports Window

Alarm Counts

You can launch the TEAM 5001 Alarm Counts application from the Monitor Menu of the Map window or from the front panel menu. The application displays accumulated alarm data divided into the three categories: Major, Minor, and Informational.
The data is arranged in four columns:

- **Alarm Type**
- **Count** – the number of occurrences that have been recorded
- **First Occurrence**
- **Last Occurrence**

### Statistics Polling

You can launch the TEAM 5001 Real Time Statistics application from the Monitor Menu of the Map window or from the front panel menu. The selection appears as Statistics Polling in both menus.

The body of the Real Time Statistics window is divided into two panels:

- **Statistics Totals** contains seven display fields and a button labeled Clear Totals. Six of the display fields show total occurrence counts of error conditions that the LTU monitors; the seventh shows Percent of Error Free Seconds. The six error conditions are those that appear on the Local Reports display, and they are defined in the description of that display on page 2-9 of this manual. The totals displayed in Real Time Statistics window are the counts accumulated either since the TEAM 5001 application started running or since the last time the Clear Totals button was clicked.

- **Statistics Polling** contains the Poll Interval field and the Poll Time display. You can select the Poll Interval for the window to be 5 seconds (default), 10 seconds, 15 seconds, or 60 seconds. When you change the Poll Interval, the application automatically saves the new value. The Poll Time display shows the time period over which count totals have been accumulated. Poll Time is initialized when the TEAM 5001 application starts running and when the Clear Totals button is clicked.
The footer, bottom margin, of the Real Time Statistics window displays two items of information:

- **Status**, in the left corner, indicates whether or not the SC 5001 LTU is presently responding to polling; it displays either Unit Responding or Unit Not Responding.

- **History**, in the right corner, provides indication of past polling problems; it displays No Errors when all polls have been responded to, and it displays Poll Failed when there has been a poll without a response. The Poll Failed message remains on display, even when successful polling has resumed, as an indication that counts may be inaccurate. The History display returns to No Errors when you reset the counts by clicking on the Clear Totals button.

*Figure 2-7* illustrates the Real Time Statistics window.

---

**Administer Functions**

Two TEAM 5001 functions appear on the Administer menu: Configuration and Maintenance.

**Configuration**

You can launch the TEAM 5001 Configuration application from the Administer menu of the Map window or from the front panel menu.

When you launch the application, it initially displays the read-only TEAM 5001 Configuration window, which has a File menu and a Navigate menu in its menu bar.

The File menu contains selections for loading and saving configurations:

- Refresh, by which you can discard pending (unsaved) configuration changes
- Save to Unit, which puts configuration changes into effect in the LTU
- Load Template, by which you can recall an LTU configuration saved as a template on the workstation
• Save to Template, by which you can save an LTU configuration on the workstation
• Compare to Template, by which you can check for differences between the current configuration and a stored template
• Exit, by which you can dismiss the window.

The Navigate menu enables you to access the read/write windows by which you can configure various aspects of operation:
• Shelf Interface
• Interfaces
• Alarms Reported

The TEAM 5001 Configuration application is fully described in *Chapter 3, Configuration*.

**SC 5001 Maintenance**

You can launch the TEAM 5001 Maintenance application from the Administer menu of the Map window or from the front panel menu.

The application displays one read/write window by which you can control some aspects of operation that fall outside the scope of Configuration. The TEAM 5001 Maintenance application is fully described in *Chapter 4, Maintenance*.

**Diagnostics**

You can launch the TEAM 5001 Diagnostics application from the Diagnose menu of the Map window or from the front panel menu.

The application displays one read/write window by which you can control a variety of test functions on the LTU. The TEAM 5001 Diagnostics application is fully described in *Chapter 5, Diagnostics*.

**Miscellaneous Functions**

**Information**

You can launch the TEAM 5001 Information window from the Misc menu of the Map window or by double clicking on the GDC logo in the Front Panel display.

Information displays one read-only window that contains the name of the application, software revision level information, and copyright information. The File menu in the menu bar contains only the selection Exit, by which you can dismiss the window.

![TEAM 5001 Information Window](image.png)

**Figure 2-8** TEAM 5001 Information Window
Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-9) from the Misc menu of the Map window. The setting you select in this window determines the initial polling rate for Front Panel displays each time they are opened.

The rate selection is a global function. It selects initial polling rate for all front panel displays linked to a TEAM Core application, regardless of which individual application you access it from.

There are four selections, each accompanied by a checkbox:
- Slow
- Normal
- Fast
- Demand Poll Only

The File menu in the menu bar contains two selections: Save to File and Exit.

To set the desired polling rate, first click on the appropriate checkbox and then select Save to File from the File menu. The precise polling frequency that results from a setting of Slow, Normal, or Fast depends on a number of factors. The higher the rate, the more communication and processor capacity is devoted to maintaining the display.

The polling rate for an individual front panel display can be changed for the duration of a session by means of the Auto Poll selection in the Select button menu. Changes you make with that menu selection are not retained when the display is closed.

To dismiss the window, select Exit from the File menu.

Figure 2-9  Front Panel Poll Rate Window

Note Pad

You can launch the Note Pad application from the Misc menu of the Map window. The application opens a shell tool on the workstation running the TEAM software. You can use the shell tool to run a text editor, mail tool, or any other software that resides on the workstation. The Note Pad application provides this access for keeping records on the system.
Introduction

The TEAM 5001 Configuration application enables you to set all the options in the SC 5001 Line Terminating Unit through a convenient group of configuration windows.

To Start TEAM 5001 Configuration

You can start the TEAM 5001 Configuration application by either of two methods:

- Select an LTU symbol on the shelf submap, then select the Configuration option from the Administer menu.
- Click on the Select button of the Front Panel display, then click on Administer and select Configuration from the resulting menu.

Templates

You can store configuration settings as templates on the workstation that runs the TEAM 5001 application. A template stores a complete configuration for all the LTU options, and you can store as many templates as you need.

To load configuration settings from a template into the LTU you must perform the following steps:

1. Select Load Template from the File menu and select the template from the resulting dialog window. The application retrieves the configuration settings of the selected template.
2. Select Save to Unit from the File menu. The application makes the template configuration settings the current operating configuration for the LTU.

Configuration Procedure

The following steps describe how to use the configuration application, and illustrate the functions of the Main Configuration window menus.

1. Access the Main Configuration window, either from the submap or from the Front Panel display. The application reads the current Main configuration from the LTU when you open the Main window.

   You can select to base your configuration changes on either the current configuration or a stored configuration template. In either case, the LTU continues to operate using its unchanged current configuration.

   The Refresh selection on the Main window File menu causes the application to read the current configuration from the LTU. All changes to all configuration windows that have not previously been saved to the LTU or a template are lost when you select Refresh.

2. To edit the current configuration of the LTU, proceed directly to the Navigate menu as described below.
To edit a template, select **Load Template** from the File menu and select a template from the resulting list.

3. Click on the **Navigate button** to display a menu of the configuration windows, and select the one in which you intend to make changes.

4. Make changes as needed in the configuration window. When you click on the input field for an option, a window opens to display all the values the field can be set to. Click the mouse on the value you select. When you change the value or setting of an option, the application displays the option name and the new value in white, rather than black, type. They remain white until you either save the changes to the LTU or a template by means of the Main window File menu, or restore the option to its last stored value or setting.

You can discard changes to a configuration window and return all its fields to their stored values in two ways:

- Click on the **Reset button** to discard changes while keeping the window open
- Click on the **Cancel button** to discard changes and close the window.

You can close a configuration window without losing changes by clicking on either the **OK button** or the **pushpin icon**, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between them by clicking the mouse on the one in which you intend to operate. The Main Configuration window remains on-screen throughout the configuration process.

5. When you have accessed all the configuration windows that you need to and made all of your changes, click on the **File menu button** of the Main Configuration window. From that menu you can select **Save to Unit** to save the new configuration in the LTU, or select **Save to Template** to save it as a template in the workstation.

When you select Save to Unit, the changed configuration becomes the current configuration for the LTU.

6. When you select Save to Template, a window appears containing a list of existing templates and a field for entering a new template name. You can select an existing template to be overwritten with the new configuration, or enter a name to create a new template. A stored template is available to be loaded by the application and then saved, with or without further modification, to any SC 5001 LTU.

**Configuration Option Values**

When you click the mouse on the entry field for a configuration item, a window opens containing all the values that are permitted for that configuration item. Hold down the mouse button until the highlight is on the value you intend to configure, then release the button. The newly selected value appears in the entry field for the configuration item.

**Main Configuration Window**

The Main Configuration window has two pull down menus, File and Navigate, that are the means by which you carry out the actual process of configuring the LTU. From the **Navigate menu** you select the configuration windows in which you make changes. It has selections for the three individual configuration windows, and an All Screens selection that opens all three windows together. The **File menu** commands the storage and retrieval of configuration settings. The contents of the two menus appear below.
The Main Configuration window title bar displays the application name, TEAM 5001 Configuration, followed by the shelf name, and the slot number of the LTU that is selected to be configured. The main body of the window contains read-only items that identify the LTU and provide information about its operations.

### Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

- **Name:** user-configured name for the LTU
- **Slot State:** Active or Inactive
- **Operational Status:** On Line or Off Line
- **Serial Number:** serial number of the LTU
- **Configuration Mode:** Hardware or Software
- **Firmware Revision:** revision level of the LTU operating code
- **DSX-1 MIB Version:** revision level of the MIB files that enable SNMP control

The TEAM 5001 application relies on the SCM and SC 5001 LTU to indicate when a configuration problem has caused an SNMP set error.
Shelf Options

The Shelf Options configuration window contains three options concerned with how the LTU interacts with the other components of its SC 5000 system.

**Network Level** – selects the length of time the SCM waits for a response from the LTU before declaring a no response alarm.

Options:
- 2 second
- 4 seconds
- 6 seconds
- 8 seconds

**Alarm Scan** – controls the LTU alarm scan.

Options:
- Enable
- Inhibit
Front Panel – permits you to disable the switches on the front panel of the LTU as protection against any inadvertent interruption of service.

Options:

Enable

Inhibit

TEAM 5001 Options

The TEAM 5001 Options configuration window contains two groups of options arranged under the headings Network and Cascade.

**Figure 3-3**  TEAM 5001 Options Configuration Window

**Network**

Line Code – sets the line code the LTU employs on the T1 link.

Options:

AMI – Alternate Mark Inversion, with no bipolar violations

B8ZS – Bipolar with eight zero substitution, with bipolar violations

Set Frame Type – sets the network framing format the LTU employs on the T1 link.

Options:

Unframed

Manual ESF – Extended Superframe Format

Auto – LTU adapts itself to ESF or D4 according to which is being received

Manual D4 – D4 Superframe

Oper Frame Type – is a read-only field that displays the Line Type and Network Framing format detected by the LTU.
**ESF Mode** – when you select ESF in the Set Line Type field you must set this field to match the type of Facilities Data Link maintenance messages that the service provider supports.

Options:

*None* – no FDL

*ANSI T1.403* – Scheduled Performance Report Messages (PRMs) and Unscheduled Messages

*TR 54016* – Telemetry Asynchronous Block Serial (TABS) protocol

**Interface Type** – sets the type of signal that the LTU transmits and receives through its network interface.

Options:

*DS1* – for connection to a Telco network; Set Line Buildout field is valid when you select DS1

*DSX1* – for short haul connection to another on-site device; Pre-Equal field is valid when you select DSX1

**Pre-Equal** – sets pre-equalization when the selected Interface Type is DSX1. Should be set to match line length between the LTU and the device it is connected to, thereby ensuring that a satisfactory signal reaches the device.

Options:

*None* – provides no pre-equalization

*130 ft* – line length of 0-130 feet

*260 ft* – line length of 130-260 feet

*390 ft* – line length of 260-390 feet

*530 ft* – line length of 390-530 feet

*655 ft* – line length of 530-655 feet

**Ones Density** – sets the technique the LTU uses to ensure that its transmit signal contains an adequate proportion of digital ones (minimum pulse density) when the Line Code option for the network side is set to AMI.

Options:

*Inhibit* – no minimum pulse density is maintained

*Max 39 Zeros* – maximum of 39 consecutive zeros can be transmitted to the network before the LTU inserts a ‘one’

*Max 15 Zeros* – maximum of 15 consecutive zeros can be transmitted to the network before the LTU inserts a ‘one’

*8 (N+1) Restrictions* – the LTU enforces a minimum of N ‘ones’ per 8(N+1) bits, where N = 1 to 24 — results in 12% average ones density

*Min 1 in 8* – the LTU enforces a minimum of 1 ‘one’ per 8 bits. Pulse density violations are enforced but enforcement is not indicated.

**DSX1 Redundancy** - in an SC 5000 system that has redundant LTUs, selects the unit to be either active or standby.
Options:

- **On-Line** – active unit
- **Backup** – standby unit
- **Keep Alive** – indicates that the unit is hardware optioned to be active, and thereby not subject to control by this option

**Signal Mode** – selects the method by which the LTU communicates with Telco switching equipment when it supports DSEs such as the SC 5034 DSE that employ switched network connections.

> If this option is not set to Robbed Bit you cannot Busy Out DS0s by means of the LTU Highway Configuration window. The LTU Configuration window is part of the Shelf Configuration application included in the TEAM core software.

Options:

- **None**
- **Robbed Bit**

**Receive** – timing from the incoming signal at the network interface

**Inband Loopback Code** – allows or prohibits the LTU from accepting a formatted (framed/unframed) in-band loopback code from another unit. The code initiates either Payload Loopback (PLB) or Line Loopback (LLB).

Options:

- **Inhibit** – prevents LTU from accepting in-band loopback code
- **PLB-Unframed** – LTU accepts unframed Payload Loopback code
- **PLB-Framed** – LTU accepts framed Payload Loopback code
- **LLB-Unframed** – LTU accepts unframed Line Loopback code
- **LLB-Framed** – LTU accepts framed Line Loopback code

**AIS Loopdown** – sets the amount of time (in seconds) that the LTU must receive a continuous Alarm Indication Signal before terminating a remotely-initiated loopback.

Options:

- **5 - 60 seconds**
- **Infinite**

**Set Line Buildout** – sets the Network Line Buildout value when the selected Interface Type is DS1.

Options:

- **Manual 0dB** – provides no attenuation
- **Manual -7.5dB** – provides -7.5dB of attenuation
- **Manual -15dB** – provides -15dB of attenuation
- **Auto** – provides attenuation based on the signal being received from the network
**Oper Line Buildout** – is a read-only field that displays the Line Buildout value currently in effect.

**Set Receive Range** – sets the sensitivity of the LTU receiver when the selected Interface Type is DS1.

Options:

- *Auto* – LTU determines receive range
- *Normal* – 0 to -28 dB
- *Extended* – -20 to -40 dB

**Oper Receive Range** – is a read-only field that displays the Receive Range value currently in effect.

**Cascade**

The following options configure the LTU Cascade port.

**Line Code** – selects the line code to be used at the Cascade port.

Options:

- *AMI* – Alternate Mark Inversion, with no bipolar violations
- *B8ZS* – Bipolar with eight zero substitution, with bipolar violations

**Set Frame Type** - sets the framing format for the Cascade port.

Options:

- *Unframed*
- *Manual ESF* – Extended Superframe Format
- *Auto* – LTU adapts itself to ESF or D4 according to which is being received
- *Manual D4* – D4 Superframe

**Oper Frame Type** – is a read-only field that displays the Line Type and Framing format detected.

**Pre-Equal** – sets pre-equalization for the DSX-1 Cascade port. Should be set to match line length between the LTU and the device it is connected to, thereby ensuring that a satisfactory signal reaches the device.

Options:

- *None* – provides no pre-equalization
- *130 ft* – line length of 0-130 feet
- *260 ft* – line length of 130-260 feet
- *390 ft* – line length of 260-390 feet
- *530 ft* – line length of 390-530 feet
- *655 ft* – line length of 530-655 feet
Alarms

The Alarms Reported configuration window (Figure 3-4) lets you configure which alarm conditions are to be reported for the LTU and which are not.

Figure 3-4  Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection field located to its left. You can select or de-select individual alarm options by simply clicking the mouse button on the appropriate selection fields. When an option is selected for its alarm to be reported, its selection field is highlighted. The selection fields next to alarm options that are not to be reported are not highlighted.

The Alarms Reported configuration window has two buttons positioned above the option fields: Report All and Report None:

- Click on Report All to highlight all the alarm option selection fields.
- Click on Report None to remove the highlight from all the alarm option selection fields.

After clicking Report All or Report None you can then change the state of individual fields as needed.
Alarms Reported Buttons

- **Report All** – unmask all LTU alarms.
- **Report None** – masks all LTU alarms.
- **Reset** – replaces the information in the fields with the most recently read information from the LTU. *Note that this button does not initiate a read of information from the LTU.*
- **OK** – saves your changes and closes the window.
- **Cancel** – cancels your changes and closes the window.

Alarms Reported Fields

**Network**

- **Loss of Signal** – occurs when the LTU detects an absence of network signal. Absence of signal for a time equivalent to 175 bits (± 75) is considered no signal.
- **Out of Frame** – occurs when the LTU misses two out of four framing bits in the signal coming from the network. The count for this alarm increments by one each time framing is lost, regardless of the number of frames affected.
- **Received Yellow Alarm** – occurs when a remote failure is detected.
- **Alarm Indication Signal** – occurs when the LTU receives an AIS from the network.
- **Unavailable Signal State** – occurs in response to 10 consecutive severely errored seconds. The state is considered cleared when the LTU has processed 10 consecutive seconds of data without a severely errored second.
- **Excessive Zeros** – occurs when Max 15 Zeros or Max 39 Zeros is the configured selection for Ones Density and the LTU has to insert ones in the signal it transmits toward the network. The selected option determines the threshold for ones insertion and occurrence of this alarm. The LTU inserts ones when the transmit signal would otherwise contain fewer ones than the Ones Density option requires.

When this alarm is valid Low Average Density is not. Neither alarm is valid when No Enforcement is the option selected for Ones Density.

- **Low Average Density** – occurs when 8(N+1)Restrict is the configured selection for Ones Density and the LTU has to insert ones in the signal it transmits toward the network. The LTU inserts ones when the transmit signal would otherwise contain fewer ones than the Ones Density option requires.

When this alarm is valid Excess Zeros is not. Neither alarm is valid when No Enforcement is the option selected for Ones Density.

- **Controlled Frame Slips** – occurs when the LTU drops frames to compensate for timing discrepancies with the network.

- **BPV** – lets you mask or unmask Bipolar Violation alarms. A network Bipolar Violation occurs when the signal the LTU receives at its network interface does not alternate between signal levels as required for Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8ZS) data encoding.

If you unmask this alarm field, you must designate a window and a threshold. The window defines a time period within which the threshold must be exceeded in order for the LTU to generate the alarm. For example, a window of one minute and a threshold of >100 specify that more than 100 alarm events must be detected within the one minute window before an alarm is generated.
Options:

*BPV Window* – report all, or configured time span.

*BPV Threshold* – minimum number of alarm events within the specified window required to generate the alarm.

**CRC** – lets you mask or unmask CRC error alarms. A network CRC error occurs when ESF framing is in use and the CRC-6 code calculated for a frame at the receiving unit does not match the CRC-6 code calculated by the unit that transmitted the frame. The LTU performs CRC checking on every ESF frame to detect errors in the DS1 signal.

If you unmask this alarm field, you must designate a window and a threshold. The window defines a time period within which the threshold must be exceeded in order for the LTU to generate the alarm. For example, a window of one minute and a threshold of >100 specify that more than 100 alarm events must be detected within the one minute window before an alarm is generated.

Options:

*CRC Window* – report all, or configured time span.

*CRC Threshold* – minimum number of alarm events within the specified window required to generate the alarm.

**Cascade**

The following group of alarms appears under the heading Cascade. The alarms apply to the DSX-1 cascade port.

*Loss of Signal (C)* – occurs when the LTU detects an absence of DSX-1 signal. Absence of signal for a time equivalent to 175 bits (± 75) is considered no signal.

*Out of Frame (C)* – occurs when the LTU misses two out of four framing bits in the signal it is receiving at the DSX-1 port. The count for this alarm increments by one each time framing is lost, regardless of the number of frames affected.

*Received Yellow Alarm (C)* – occurs when a remote failure is detected at the DSX-1 port.

*Alarm Indication Signal (C)* – occurs when the LTU receives an AIS at the DSX-1 port.

*Unavailable Signal State (C)* – occurs in response to 10 consecutive severely errored seconds. The state is considered cleared when the LTU has processed 10 consecutive seconds of data without a severely errored second.

*BPV (C)* – lets you mask or unmask Bipolar Violation alarms. A DSX-1 Bipolar Violation occurs when the signal the LTU receives at its DSX-1 interface does not alternate between signal levels as required for Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8ZS) data encoding.

If you unmask this alarm field, you must designate a window and a threshold. The window defines a time period within which the threshold must be exceeded in order for the LTU to generate the alarm. For example, a window of one minute and a threshold of >100 specify that more than 100 alarm events must be detected within the one minute window before an alarm is generated.

Options:

*BPV Window (C)* – report all, or configured time span.

*BPV Threshold (C)* – minimum number of alarm events within the specified window required to generate the alarm.
CRC (C) – lets you mask or unmask CRC error alarms. A DSX-1 CRC error occurs when ESF framing is in use and the CRC-6 code calculated for a frame received at the DSX-1 port does not match the CRC-6 code calculated by the LTU that sent the frame. The LTU performs CRC checking on every ESF frame to detect errors in the DSX-1 signal.

If you unmask this alarm field, you must designate a window and a threshold. The window defines a time period within which the threshold must be exceeded in order for the LTU to generate the alarm. For example, a window of one minute and a threshold of >100 specify that more than 100 alarm events must be detected within the one minute window before an alarm is generated.

Options:

- **CRC Window (C)** – report all, or configured time span.
- **CRC Threshold (C)** – minimum number of alarm events within the specified window required to generate the alarm.

**Unit Alarms**

The following group of alarms appears under the heading Unit.

**Status Change** – occurs when there is a change in the configuration of the LTU.

**Timing Loss** – occurs when the LTU loses its source of Network Transmitter Timing.

**Fallback Timing Active** – occurs when the LTU is operating by means of its fallback source of Network Transmitter Timing.
Introduction

The TEAM 5001 Maintenance application provides three functions for maintaining the SC 5001 Line Terminating Unit.

To Start TEAM 5001 Maintenance

You can start the TEAM 5001 Maintenance application by either of two methods:

- Select a LTU symbol on the shelf submap, then select Maintenance from the Administer menu.
- Click on the Select button of the Front Panel display, then click on Administer and select Maintenance from the resulting menu.

The window title bar displays the application name, TEAM 5001 Maintenance, followed by the shelf name, and the slot number of the LTU that is selected. The main body of the window contains read-only items that display current settings of the maintenance options for the LTU. The two pull down menus, File and Edit, are the means by which you carry out the actual process of setting maintenance options for the selected LTU. Note that only one option can be set at a time. See Figure 4-1.

![Figure 4-1 Maintenance Options Window](image_url)
Maintenance Procedure

1. Access the Maintenance window, either from the submap menu or from the Front Panel display. The application reads the current maintenance settings from the LTU when you open the window.

2. Click the mouse on any of the three Maintenance buttons.

Maintenance Window Buttons

The Maintenance window provides three buttons that perform the following functions.

**Front Panel** – the Maintenance window Front Panel button displays either Inhibit Front Panel or Enable Front Panel as its label. The label indicates the result of clicking on the button, so that Inhibit Front Panel displayed on the button indicates the LTU front panel switches are currently enabled.

**Reset to Factory Defaults** – causes the LTU to perform a power-on reset and resume operation using its default configuration values.

**Perform Soft Reset** – causes the LTU to perform a power-on reset and resume operation while retaining its current configuration values.
5 Diagnostics

Introduction

The TEAM 5001 Diagnostics application enables you to perform a variety of tests on the SC 5001 LTU. You can start the application by either of two methods:

- Select an LTU symbol on the shelf submap, then select Diagnostics from the Diagnose menu.
- Click on the Select button of the Front Panel display, then click on Diagnose and select Diagnostics from the resulting menu.

Diagnostics Window

![Diagnostics Window](Image)

**Figure 5-1** Diagnostics Window
The Diagnostics window, shown in Figure 5-1, is divided into six functional areas:

- Name field – identifies the selected LTU
- DS0 panel – by which you can command diagnostic tests on a single DS0, thereby permitting normal operations to continue on the rest of the T1 link
- DS1 panel – by which you can command diagnostic tests that involve the entire T1 (DS1) line
- Graphic panel (unlabeled) – depicts the path followed by test data during the current test.
- Time/Results panel – contains Test Time selection field (30 seconds, 1 to 10 minutes in 1-minute increments, 15 to 30 minutes in 5-minute increments); Stop Test button; Time Remaining and Test Results display fields
- DS1 Delay Test/DS1 Receive Level panel – contains buttons for initiating delay and receive level tests, and display fields for results

The File menu contains only the selection Exit, by which you can dismiss the TEAM 5001 LTU Diagnostics window. The Navigate menu contains only the selection History, which provides access to the Diagnostic History window. The history window is described later in this chapter.

### DS0 Tests

The DS0 panel of the Diagnostics window enables you command either of two tests that involve a single selected DS0 and the far-end unit that the DS0 is directed to through the network: an end-to-end self test and a loopback to the far-end unit.

The DS0 panel has the following features:

- Channel selection field (this field also selects DS0 for DS0 Delay Test, described later in this chapter)
- Loopback selection, with check boxes for None or Loop
- Pattern selection, with check boxes for None, 511, 2047, QRS, or 3 in 24
- Start Test button

#### DS0 End-to-End Test Procedure

The DS0 end-to-end test involves the LTU generating a test pattern and transmitting it to a remote unit to be checked for errors. At the same time, the remote unit sends a test pattern to the LTU, which performs error checking on the pattern it receives. Figure 5-2 illustrates the data path for this test.

![Figure 5-2 DS0 End-to-End Self-Test](image-url)
The Test Results field of the TEAM 5001 LTU Diagnostics window displays bit error results for the signal that the LTU receives. The test must be initiated at both ends, and the same test pattern must be transmitted from both ends.

Use the following procedure to perform a DS0 end-to-end test:

1. If the remote unit can be controlled from your workstation, access the appropriate diagnostic function in order to initiate transmission of the test pattern from the far end. Otherwise, contact an operator at the remote site and arrange to coordinate the test.

2. Click on the Channel selection field and select from the resulting display the DS0 you intend to test.

3. Click on the Loopback selection check boxes None.

4. Click on the Pattern selection check boxes next to the test pattern you intend to transmit. Remember that the unit at the far end must transmit the same test pattern as the LTU.

5. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the test to run.

6. Click on the Start Test button at the bottom of the DS0 panel. While the test runs the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the test before the selected time elapses by clicking on the Stop Test button.

7. When the test is complete the Test Results field displays the bit-error count.

**DS0 Loop Test Procedure**

The DS0 Loop test involves the LTU establishing a loopback toward the far end on the selected DS0. *Figure 5-3* illustrates the data path for this test.

Test pattern generation and checking is entirely the responsibility of the far end unit, and there are no results to be displayed in the TEAM 5001 LTU Diagnostics window.

![Figure 5-3 DS0 Loopback](image-url)
3. Click on the Loopback selection check boxes Loop.
4. Click on the Pattern selection check boxes None.
5. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the loopback to be in effect.
6. Click on the Start Test button at the bottom of the DS0 panel. While the loopback is in effect the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the loopback before the selected time elapses by clicking on the Stop Test button.

**DS1 Tests**

The DS1 panel of the Diagnostics window enables you command a variety of two tests that involve the entire T1 (DS1) line connected to the LTU.

The DS1 panel has the following features:

- **Loopback selection**, with the following check boxes:
  - None
  - Line – selects a loopback toward the network at the LTU line interface; Pattern selection is neither needed nor available when this is selected
  - Payload – selects a loopback toward the network internal to the LTU; Pattern selection is neither needed nor available when this is selected
  - Cascade – selects a loopback toward the network at the LTU cascade (DSX-1) interface; Pattern selection is neither needed nor available when this is selected
  - Local Test – selects a loopback of transmit data at the LTU line interface; Pattern selection is required when this is selected
  - Remote Loop – selects a loopback of transmit data at the remote unit(s) linked to the LTU; Pattern selection is required when this is selected
  - Network Interface – selects a loopback of transmit data at the Telco line connector; Pattern selection is required when this is selected

- **Pattern selection**, with check boxes for None, 511, 2047, QRS, or 3 in 24

- **Start Test button**

**DS1 Line, Payload, and Cascade Loopback Procedure**

The DS1 Line, Payload, and Cascade Loopbacks each involve the LTU establishing a loopback toward the far end at a selected point within the LTU. Line and Payload loopbacks loop the entire DS1 connection, while the Cascade loopback loops only the DS0s that are directed to the LTU cascade interface. *Figure 5-4* illustrates the data paths for all three loopbacks.

Test pattern generation and checking for these three loopbacks is the responsibility of remote site equipment, and there are no results to be displayed in the TEAM 5001 LTU Diagnostics window.

1. If the remote unit can be controlled from your workstation, access the appropriate diagnostic function in order to initiate transmission of a test pattern from the far end. Otherwise, contact an operator at the remote site and arrange to coordinate the test.
2. Click on the chosen Loopback selection check box: Line, Payload, or Cascade. The Pattern selection check boxes are grayed out when you select any of these three loopbacks.
3. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the loopback to be in effect.
4. Click on the Start Test button at the bottom of the DS1 panel. While the loopback is in effect the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the loopback before the selected time elapses by clicking on the Stop Test button.

![Figure 5-4](image)

**Figure 5-4** DS1 Loopbacks to the Network

**DS1 Local Test Procedure**

The DS1 Local Test involves the LTU generating a test pattern, directing that pattern through its internal circuits with a loopback at the line interface, and checking the pattern for errors. *Figure 5-5* illustrates the data path for this test.

The Test Results field of the TEAM 5001 LTU Diagnostics window displays bit error results at the end of the test. Since the test is completely internal to the LTU, the occurrence any error on this test constitutes an unacceptable result.

![Figure 5-5](image)

**Figure 5-5** DS1 Local Test

1. Click on the Loopback selection check box Local Test.
2. Click on the Pattern selection check box next to the test pattern you intend to use.
3. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the test to run.
4. Click on the Start Test button at the bottom of the DS1 panel. While the test runs the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the test before the selected time elapses by clicking on the Stop Test button.

5. When the test is complete the Test Results field displays the bit-error count.

**DS1 Remote Loop Procedure**

The DS1 Remote Loop test involves the LTU transmitting a command to place its remote unit(s) in loopback, then generating a test pattern, transmitting that pattern to the remote(s), and checking the pattern for errors when it is received back. The LTU performs its error checking on a DS0-by-DS0 basis, so the results of this test are valid whether the LTU has a single remote or multiple remotes. *Figure 5-6* illustrates an example of the data path for this test.

The Test Results field of the TEAM 5001 LTU Diagnostics window displays bit error results at the end of the test. Since the test involves the Telco link and one or more remote units, detection of errors indicates the need for further testing to isolate their source.

---

**Figure 5-6  DS1 Remote Loop Test**

1. Click on the Loopback selection check box Remote Loop.
2. Click on the Pattern selection check box next to the test pattern you intend to use.
3. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the test to run.
4. Click on the Start Test button at the bottom of the DS1 panel. While the test runs the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the test before the selected time elapses by clicking on the Stop Test button.
5. When the test is complete the Test Results field displays the bit-error count.
DS1 Network Interface Loopback Procedure

The DS1 Network Interface loopback test involves the LTU transmitting a command that places its Telco interface to the T1 line in loopback, then generating and transmitting a test pattern that loops back at the Telco interface, and checking the pattern for errors when it is received back. Figure 5-7 illustrates the data path for this test.

The Test Results field of the TEAM 5001 LTU Diagnostics window displays bit error results at the end of the test. Errors detected by this test may be occurring either in the LTU or in the connection between it and the Telco interface.

![SC 5001 LTU](image)

**Figure 5-7** DS1 Network Interface Test

1. Click on the Loopback selection check box Network Interface.
2. Click on the Pattern selection check box next to the test pattern you intend to use.
3. Click on the Test Time selection field below the graphic display panel and select from the resulting display how long you want the test to run.
4. Click on the Start Test button at the bottom of the DS1 panel. While the test runs the Time Remaining field displays a bar graph that shows what percentage of the selected test time remains. You can end the test before the selected time elapses by clicking on the Stop Test button.
5. When the test is complete the Test Results field displays the bit-error count.

**DS0 Delay Test**

The DS0 Delay Test involves the LTU transmitting a command to place a selected DS0 in loopback at a remote unit, then generating and transmitting a signal on that DS0 to be looped back by the remote. The LTU measures the time required for the round trip and displays the result.

1. Click on the Channel selection field in the DS0 panel and select from the resulting display the DS0 you intend to use for the delay test.
2. Click on the DS0 Delay Test button. The Time Remaining field displays its bar graph as an indication that the test is in progress. The measured delay time, in milliseconds, appears in the display field beside the DS0 Delay Test button when the test is complete.
DS1 Receive Level

The LTU measures the strength of the signal it is receiving on the T1 line when you click on the DS1 Receive Level button. While the measurement is being performed the Time Remaining field displays its bar graph as an indication that the test is in progress. The measured receive level, in dBm, appears in the display field beside the DS1 Receive Level button when the test is complete.

Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting History from the Navigate menu in the TEAM 5001 LTU Diagnostics window. The record appears as a listing in the Diagnostics History window (see Figure 5-8).

![Diagnostics History window](image)

**Figure 5-8**  Diagnostics History window

The Diagnostics History window displays information in five columns:

- **Start Time**: day, date, and time test began
- **Test**: the test conducted
- **Pattern**: the test pattern used, if applicable
- **Test Time**: the duration of the test
- **Test Results**: the test result. OK is displayed for a test that does not involve a test pattern supplied by the LTU or for a test with a test pattern in which no errors occurred. Bit Errors is displayed, followed by a bit error number, for a test with a test pattern in which errors were found.

For a test that does not employ an LTU-supplied test pattern, such as a loopback to the far end, OK in the Test Results column indicates only that the test mode was initiated successfully. Since these test modes provide the data path for a test signal without generating or checking the signal, the application has no error rate data to display for them.

To close the Diagnostics History window, click on the pushpin icon in the upper left corner of the window or the OK button at the bottom. During an ongoing diagnostic session, you can close and re-open the Diagnostics History window without loss of display data.

The application clears the Diagnostics History window when you exit from the diagnostics window.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer Functions</td>
<td>2-12</td>
</tr>
<tr>
<td>Alarms Configuration</td>
<td>3-9</td>
</tr>
<tr>
<td>Common Window Features</td>
<td>2-6</td>
</tr>
<tr>
<td>Configuration</td>
<td>3-1</td>
</tr>
<tr>
<td>Configuration Procedure</td>
<td>3-1</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>5-1</td>
</tr>
<tr>
<td>Diagnostics History</td>
<td>5-8</td>
</tr>
<tr>
<td>Diagnostics Window</td>
<td>5-1</td>
</tr>
<tr>
<td>DS0 Delay Test</td>
<td>5-7</td>
</tr>
<tr>
<td>DS0 Tests</td>
<td>5-2</td>
</tr>
<tr>
<td>DS1 Receive Level</td>
<td>5-8</td>
</tr>
<tr>
<td>DS1 Tests</td>
<td>5-4</td>
</tr>
<tr>
<td>Front Panel</td>
<td>2-2</td>
</tr>
<tr>
<td>Main Configuration Window</td>
<td>3-2</td>
</tr>
<tr>
<td>Maintenance</td>
<td>4-1</td>
</tr>
<tr>
<td>Maintenance Procedure</td>
<td>4-2</td>
</tr>
<tr>
<td>Maintenance Window Buttons</td>
<td>4-2</td>
</tr>
<tr>
<td>Menu Bar Access</td>
<td>2-1</td>
</tr>
<tr>
<td>Miscellaneous Functions</td>
<td>2-13</td>
</tr>
<tr>
<td>Monitor Functions</td>
<td>2-6</td>
</tr>
<tr>
<td>SC 5000 System Components</td>
<td>1-1</td>
</tr>
<tr>
<td>SC 5001 LTU</td>
<td>1-2</td>
</tr>
<tr>
<td>Shelf Options</td>
<td>3-4</td>
</tr>
<tr>
<td>TEAM 5001 Applications</td>
<td>1-2</td>
</tr>
<tr>
<td>TEAM 5001 Options</td>
<td>3-5</td>
</tr>
<tr>
<td>Templates</td>
<td>3-1</td>
</tr>
</tbody>
</table>